
   
Empowered by Innovation

PC Attendant
User Guide

P/N 0893415
Rev 2, June 2006
Printed in U.S.A.

0.5.7.0



 

This manual has been developed by NEC Unified Solutions, Inc. It is intended for the use of its customers and
service personnel, and should be read in its entirety before attempting to install or program the system. Any
comments or suggestions for improving this manual would be appreciated. Forward your remarks to:

 

NEC Unified Solutions, Inc.

 

4 Forest Parkway
Shelton, CT 06484

 

necunifiedsolutions.com

 

Nothing contained in this manual shall be deemed to be, and this manual does not constitute, a warranty of, or
representation with respect to, any of the equipment covered. This manual is subject to change without notice and
NEC Unified Solutions, Inc. has no obligation to provide any updates or corrections to this manual. Further, NEC
Unified Solutions, Inc. also reserves the right, without prior notice, to make changes in equipment design or
components as it deems appropriate. No representation is made that this manual is complete or accurate in all
respects and NEC Unified Solutions, Inc. shall not be liable for any errors or omissions. In no event shall NEC Unified
Solutions, Inc. be liable for any incidental or consequential damages in connection with the use of this manual. This
document contains proprietary information that is protected by copyright. All rights are reserved. No part of this
document may be photocopied or reproduced without prior written consent of NEC Unified Solutions, Inc.

©2006 by NEC Unified Solutions, Inc. All Rights Reserved.
Printed in U.S.A.



 

Table of Contents

                       
Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Installation Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Installation Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  5
System Limitations and Installation Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  6

Opening PC Attendant . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Operation Conditions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Opening PC Attendant  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7

User Profiles  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Main Screen . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Resizing the Main Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  9
Title Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Menu Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  10
Function Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Call Control Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  14
BLF Panel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  15
Status Bar  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  16

Automatic Voice Greetings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Playing a Personal Greeting  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  17

Call Forwarding  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
Forwarding the Attendant Console . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  18

Call Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Call Recording  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24
Recording the Active Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  24

Camp On . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Using Camp On for a Busy Extension  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  25

Central Office Calls, Answering  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Answering Incoming Calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26
Disconnecting a Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  26

Central Office Calls, Placing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Placing an Outbound Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27
Disconnecting a Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  27

Conference . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28
Setting Up a Conference Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  28
Aspire PC Attendant User Guide ◆ Table of Contents- 1



 

Table of Contents

                         
Directory / Contact List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Adding a new entry to the Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  30
Modifying an entry in the Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Deleting an entry from the Directory  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Searching the Directory and Contact/Personal Lists. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Printing the Directory or Contact/Personal List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Changing the Directory/Contact/Personal List Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Call Handling within the Directory/Contact/Personal List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  33
Sending a Message from the Directory . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  34
Adding a new entry to the Contact/Personal List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
Modifying an entry in the Contact/Personal List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35
Deleting an entry from the Contact/Personal List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  35

Do Not Disturb  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36
Placing the Attendant Console in Do Not Disturb  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  36

EMail  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37
EMail: Send an EMail Using a BLF/DSS Key . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  37

Hold  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
Placing a Call On Hold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38
Retrieving a Call on Hold . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  38

Night Service . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39
Setting the Telephone System in Night Mode  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  39

Paging  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Displaying Internal Page Zones 1-64  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  40
Accessing the Paging System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  41

Park  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
Parking/Unparking a Call . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  42

Quick Message Utility  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 43
Accessing the Quick Message Utility . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  43
Composing a Quick Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  44
Receiving a Response to a Quick Message. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  45
Clearing a Quick Message from the Active Call List . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  46

Telephony Administrator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Transfer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49
Transferring a Call  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Voice Mail  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Voice Mail: Leave a Message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51

Voice Over . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52
Using Voice Over to a Busy Extension. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52
Table of Contents - 2 ◆ Aspire PC Attendant User Guide



 
Introduction

 

Introduction

          
Introduction

Introduction The PC Attendant Console is a software product that provides access to the most common functions required 
by an operator or receptionist. By using this application in conjunction with an Aspire S, M, L, or XL sys-
tem, the attendant can easily manage their call handling tasks without having to switch their attention 
between the telephone and the PC. A company directory, recording capability, and PC-to-PC messaging, 
provide additional features to further enhance the operation. (The attendant telephone requires a CTU 
Adapter (P/N 0890059) installed with connection directly to the end-user PC for the Call Recording and 
Personal Greeting voice functions.)

The PC Attendant application uses a CTI (Computer Telephony Integration) service that is provided with 
the product in order to integrate with the Aspire telephone systems. Through the CTI service, an ethernet 
connection over the company LAN, and an Aspire keyset for audio, the PC Attendant application is able 
to monitor all extensions on the phone system and control the actions of the attendant�s phone, including 
placing calls.

The CTI service on the PC communicates with the Aspire system through the CTI port on the telephone 
system. An administration utility (Telephony Administrator) is provided which allows the system admin-
istrator to conÞgure the global settings for the console application.

The following diagram shows the system conÞguration for a single console installation.

The PC Attendant application can also be installed on multiple PCs for installations that need to support 
more than one attendant position (each attendant PC would require a licensed version of the PC Atten-
dant installed). Up to 8 PC Attendant positions can be installed.

The PC Attendant application also includes a supporting application, call Quick Message. By installing 
the Quick Message client on individual PCs, the attendant is able to quickly send short messages to other 
employees, who can respond with a single keystroke.

The host PC to be used as the CTI Server requires Windows XP, Windows 2000, or Windows 2003 and 
an interface to the Aspire system through the 3rd-party CTI link to monitor and control the telephone 
activity (Windows Small Business Server 2003 is not currently supported by the Aspire CTI/TAPI server). 
When installing the PC Attendant Console on multiple PCs for more than one attendant position, the PC 
requires Windows XP, Windows 2000 or Windows 2003. (Note that if the client PC is to be used for 
other TAPI 2 applications (ex: Microsoft Outlook dialing), you would need to use Windows 2000 or 
2003 - Windows XP will not support all TAPI 2 applications. 
Aspire PC Attendant User Guide ◆ 1
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The following diagram shows an example of a system conÞguration for a multi-console installation. A max-
imum of eight attendant consoles can be connected to a single CTI Server.
2 ◆ Aspire PC Attendant User Guide



 
Introduction

 

Requirements

                                                      
Requirements

Requirements for PC Attendant
This section describes the requirements for the PC Attendant Console. 

Note: With the release of the PC Attendant 0.3.0, all servers and clients with the applica-
tion installed, must be updated to 0.3.0 or later software. Version 0.3.0 is not compatible 
with earlier versions of the PC Attendant Console.

Telephone System 
The PC Attendant Console will work with digital keysets for all Aspire systems (Aspire S, Aspire M, Aspire 
L, or Aspire XL). The TAPI 2 function is required for the PC Attendant. This means that with the Aspire 
M, a Feature Upgrade PAL chip is required. The Aspire L/XL systems use the enhanced NTCPU which 
provides the TAPI function.

A keyset is required for the attendant to provide audio for the call. The operator can use the handset or con-
nect a headset for easier operation.

Operating System Support
The PC Attendant application can be used with Windows 2000, Windows 2003 and Windows XP.

Windows Small Business Server 2003 is not currently supported by the Aspire CTI/TAPI server.

PC Requirements
The PC requirements for running the CTI Server can vary depending on the number of stations that will be 
monitored and the number of Console applications that will be used. However, the following guidelines are 
the recommended PC components.

CTI Server / Stand-Alone PC:
A dedicated PC is recommended for the Aspire CTI Server.

Processor: Pentium III, 800 MHz 
Memory: 512M RAM
Available Hard Disk Space: ● 10M for installation

● 75M for .NET framework (if not already installed)
● 5M for directory and conÞguration Þles

Media: CD-ROM
Communications: Ethernet Port
USB Port: Required for license key

PC with Console Application:
Processor: Pentium III, 500 MHz 
Memory: 256M RAM
Available Hard Disk Space: ● 10M for installation

● 75M for .NET framework (if not already installed)
● 2M+ for call log, based upon call volume and call recording

Media: CD-ROM
Communications: Ethernet Port
USB Port: Required for license key

A second USB port, if recording or personal greeting required
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Installation Steps

Installation Steps
Refer to the Aspire PC Attendant Manual, P/N 0893142, for step-by-step installation instructions.

Note: With the release of the PC Attendant 0.3.0, all servers and clients with the application 
installed, must be updated to 0.3.0 or later software. Version 0.3.0 is not compatible with earlier 
versions of the PC Attendant Console.

1. In the Aspire system, for any extension to be used as a PC Attendant, set the extension�s Class 
of Service option in Program 20-13-06 : Class of Service Options (Supplementary Ser-
vice) - Automatic Off Hook Signaling to �1�. This setting is required to ensure the proper 
operation for Voice Mail, Camp-On and Voice Over.

2. If a CTU Adapter (P/N 0890059) is to be installed on any keyset which will be assigned to the 
PC Attendant as an operator, the CTU driver must be installed on the PC prior to the TAPI 2 
driver. 

If the TAPI 2 has been installed prior to the CTU driver, the TAPI 2 must be removed 
from the system (using Start-Setting-Control Panel-Add or Remove Programs-
AspireTSP), then install the CTU driver, followed by reinstalling the TAPI 2 driver. (The 
PC Attendant program would not need to be removed in this case.)

If the CTU driver and TAPI drivers is not installed Þrst, there could be unexpected 
interactions with the PC Attendant application. If you wish, you can install the CTU driver 
prior to any installation, whether a CTU will be used or not - it will not affect an installa-
tion. This would prevent you from having to uninstall all the PC Attendant applications 
and reinstalling should it be determined later that a CTU is required.

3. Install the third-party CTI (TAPI 2) driver on the PC which will be used to run the CTI Ser-
vice (this is the host PC to which any other client PCs will be connected when multiple oper-
ators are used). This must be installed prior to installing the PC Attendant application.

If the Aspire CTI (TAPI 2) driver is installed in multi-line mode (required when virtual 
extensions need to ring the operator), you also need to make sure to set the Aspire Pro-
gram 20-23-03 : System Options for CTI - Trunk Virtual Bridge - TSP Driver to �1� 
(enabled). This allows the virtual extension information to be sent to the PC Attendant, 
enabling it to ring for incoming calls.

4. Install the PC Attendant software on the host PC. 

5. Install the PC Attendant software on any client PCs to be used for multiple operator positions. 
A maximum of 8 operator positions are possible with the PC Attendant.

6. Install the Quick Message client on any PC to which the operator should be able to send a 
message. 

It is important to remember that any time changes are made within the phone 
system which affects the line type assignment (line key/loop key) or adding 
lines or extensions, the services for the TAPI 2 server (TspStart) and PC 
Attendant server (RPCTI) must be restarted. When possible, you may also 
wish to restart the Aspire system.  Refer to the PC Attendant Manual for 
details on restarting the services.
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System Limitations and Installation Tips
● Universal Serial Bus Support : To enable voice recording or personal greeting, each PC that 

requires this functionality must have a USB adapter installed in the associated digital tele-
phone and connected to the user's PC.

● Busy Lamp Field : Using the 3rd party CTI interface, any extension on the system can be 
monitored to show the current status with the BLF capability. 

● Attendant to PC Messaging : The PC Attendant Console is able to send short text messages 
to other employees using the company's Local Area Network (LAN). This functionality could 
be used, for example, to alert an employee of an important incoming call if they are already on 
the telephone. In order to be able to receive and respond to these messages, a small client 
application, Quick Message, needs to be installed on the employee PC (Quick Message is part 
of the Attendant Console application). The client software can be conÞgured to "pop-up" on 
the employee's PC screen when a message is received from the attendant. The employee can 
then respond to the attendant by selecting from a set of preprogrammed responses. This fea-
ture is not intended to emulate or replace a general-purpose �chat� application. It is intended 
to provide basic communication between an operator and employees within a building on a 
local area network.

Note: Quick Message is available only  to those extensions whose properties are not indicated 
as �Hidden� in the Telephony Administrator�s Directory tab.

● Multiple user proÞles can be deÞned on a single PC. This allows different individuals to use 
the same attendant workstation and maintain their own conÞguration settings.

● The Clock used on display is from the PC, not from the Aspire system.

● Check the feature access codes deÞned in the Telephony Administration conÞguration to 
ensure that they match what is programmed in the Aspire system. Refer to Telephony Admin-
istrator on page 47.

● In order to use service codes which require 1 or 2 additional digits (such as calling Door Box 
[802 + door box number] or dialing using a trunk group [804 + trunk group number]), internal 
calls must be set to 5-digits in the Special Dialing tab of the Telephony Administration conÞg-
uration. Any additional dialed digits over �5�, the PC Attendant will determine you are plac-
ing an outside call and will seize a line.

● Any new extensions/trunks installed after the CTI server has started will not be displayed in 
the PC Attendant until the CTI Server and PC Attendant CTI Server have been restarted.
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Opening PC Attendant

Opening PC Attendant
When an incoming call is received, the PC Attendant displays it on the PC and provides several features 
which allow the user to handle the call quickly using the keyboard or mouse. The attendant speaks to the 
caller through the telephone handset, headset, or speakerphone.

When there is no activity, the PC Attendant application can be minimized to run in the background and pop 
to the front when call activity occurs. 

Operation Conditions
Headset
During the installation of the TAPI 2 driver, if the Auto Headset Mode is not enabled, the PC Attendant Con-
sole application will not be able to support the use of a headset for answering calls. Refer to ConÞguring 
the NEC Aspire TAPI TSP in the PC Attendant Installation Manual (P/N 0893142) for details on chang-
ing this option.

Internal Call on Hold and Active External Call
When the attendant has an internal call on hold and an active external call: If the attendant selects the Hang 
Up function, the external call will be disconnected and the internal call will automatically be reconnected. 
This will not occur if the attendant uses the telephone keys to disconnect the active call.

Line Keys and the Telephone’s Hold Button
With an external call on a line key (and not a loop key), if the telephone�s HOLD button is pressed, the call 
can no longer be retrieved by the PC Attendant application. This operation will not occur if the outside call is 
on a loop key instead.

Opening PC Attendant
1. From the Start menu, select Programs - NEC - Aspire PC Attendant Console, or double-click on 

the Aspire PC Attendant Console icon on the desktop. The following window is displayed:

2. Enter a Login ID and Password that were set up in the User ProÞle in the Telephony Administration 
utility. Select the extension that will be used as the associated operator�s phone and click Login.
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User Profiles 

User ProÞles 
The PC Attendant Console will support saving distinct user proÞles within a single system. This function is 
beneÞcial for companies that have different individuals serving as the attendant at the same PC during the 
course of the business day. Each registered user is assigned a User ID to access the system. The proÞle for 
each user will include their preferences for screen layout, personal voice prompts (if supported), and conÞg-
uration settings. Refer to User ProÞles on page 48 for details on deÞning the proÞles.
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Main Screen
After the user has been authenticated, the application's main screen will be displayed. The main screen of the 
PC Attendant presents valuable information about the current call activity and provides easy access to the 
basic operations required by the attendant. Using either the mouse or keyboard, the user can quickly move 
between the different areas of the screen to dispatch callers, search the company directory, and view the sta-
tus of the individual lines. An example of the main screen is shown below.

The main application screen consists of the following major sections: title bar, main menu bar, function tool-
bar, call control panel, BLF tabs, and status bar. Each of these elements is further described in the following 
sections.

Resizing the Main Window
The PC Attendant Console main window can be resized using the standard Windows resizing controls. Some 
of the common resizing techniques are:

1. Position the mouse cursor on the left or right edge of the menu frame, hold down the left 
mouse button, and drag the border to change the width of the menu.

2. Position the mouse cursor on the top or bottom edge of the menu frame, hold down the left 
mouse button, and drag the border to change the height of the menu.

3. Position the mouse cursor on a corner of the menu frame, hold down the left mouse button, 
and drag the corner to change the dimensions of the menu.

4. Press the Restore/Maximize icon in the menu title bar to change the size of the frame.
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Title Bar
The title bar provides the standard window controls and access to basic operations and utilities through pull-
down menus.

The standard window controls are displayed as icons on the right side of the title bar. These include the 
options to Minimize, Maximize/Restore, or Close the main window. 

Menu Bar
The menu bar displays the function categories that are accessible from the main menu. 

Each of the selections on the main menu opens a drop-down list of all the operations that are available within 
the selected category. These operations include setting conÞguration options, viewing/editing the directory, 
and viewing/maintaining the call log.

File
● Exit - Close the PC Attendant application.

View
● Customize Toolbar - Change the visible functions and button order on the function toolbar.
● Sort BLF By Extension/First Name/Last Name - Change the sort order of the BLF buttons.

Tools
● Preferences - Customize operational settings for the PC Attendant.

Window

Call Log
Open a separate window to view the call history.

● Dial - Redial a number within a call log record.
● Play - Replay a recording from within a call log record.
● Delete - Erase a record from the call log.
● E-Mail - Send a call log record using the default EMail client.
● Print - Print all or part of the call log.
● Archive - Save all or part of the call log to a designated Þle.

Directory
Open a separate window to view the Directory/Contact List.

● New Entry - Add a new record in the company directory.
● Edit Entry - Modify the Þelds within a directory entry.
● Delete Entry - Erase a record from the company directory.
● Search - Access the search function for the company directory.
● Print - Print all or part of the company directory.

Help
● Contents and Index - Access the on-line help system by topic.
● About - View the copyright notice and current revision of the software.
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Function Toolbar
The function buttons, which appear below the Menu Bar, provide access to the operations that are most fre-
quently used by the attendant. The attendant can conÞgure the set of functions and their assigned Hotkey (a 
Hotkey is a preprogrammed key for performing the same function as the icon. Go to View - Customize 
Toolbar for the default Hotkey assignments for each function). The icons to be displayed are selected in this 
menu option. If more icons are selected than there is room to display, the icons on the right which will not Þt 
will not be displayed unless other icons are removed from the view.

A function on the toolbar can be selected by using the mouse to click on the desired function button or press-
ing the associated Function Key (F1 - F12) on the keyboard (these are deÞned under the menu item VIEW-
CUSTOMIZE TOOLBAR). Individual buttons on the Function Toolbar become disabled if the function is 
not allowed for the current state of the attendant console. For example, the Answer button is only enabled 
when a call is ringing into the attendant position. If additional information is required to complete the opera-
tion, then the Data Entry Area will become active and request further input from the attendant. For example, 
the Night Mode button would open a dialog that would allow the attendant to select the type of Night mode 
that is being initiated.

The last button on the right provides access to additional functions that are not displayed on the toolbar. When 
this button is selected, a drop down list is shown that provides access to the remaining call control functions.

The functions available on the Function Toolbar are described as follows.   

Answer an incoming call.

Place the current active call on hold.

Transfer the current active call.

Disconnect the current active call.

Initiate an outbound call from the console.

Initiate a conference call, which includes the active call.
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Send a Quick Message to another user�s PC.

Start/stop recording of the current call.

Redirect a ringing call to another destination.

Retrieve a call ringing a group using Group Call Pickup.

Redial one of the last numbers called.

Initiate a page using the telephone�s paging system.

Transfer the active call to a park location.

Retrieve a call from a designated park location.

Select the night mode to be activated.

Barge in on an extension who is active on a call.

Perform a call pickup at a ringing extension (Directed Call 
Pickup, Call Pickup, Other Group Call Pickup, or SpeciÞed 
Group Pickup).

Voice over to an extension who is active on a call.
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Set/cancel the Call Forward or DND for the PC Attendant.

Leave a message or transfer a call to an extension�s Voice 
Mail.

Use this button to view any additional options which are not 
displayed in the toolbar.
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Call Control Panel
The call control panel shows all of the active calls and messages that are currently being handled by the 
attendant. The list includes the active call, held calls, and ringing calls. The Active Call List also provides 
information about Quick Messages that have been sent by the attendant and their responses.

The top entry within the Active Call List shows the call that is currently connected to the console (active).

The text box for each call contains the call information includes the calling party information, line being 
used, and call timer. When the telephone is idle (no active call), the display is empty.

Below the Active Call are listed all of the call activity and text messages that are currently being managed by 
the attendant. This list includes held calls, ringing calls, calls placed in a park orbit by the attendant, and 
Quick Messages. Each entry displays enough information to identify the call or text message. The attendant 
is able to retrieve Held and Parked calls by clicking on the associated entry. Clicking on the Call List entry or 
selecting the Answer button answers a ringing call. If multiple calls are ringing, the Answer button automat-
ically picks up the oldest call.

Call entries within the Active Call list are automatically removed when the call is disconnected or answered.

Message entries within the Active Call list are automatically removed based upon default timers that the user 
sets. Message entries can also be deleted manually by performing a right mouse click on the entry and 
selecting the Delete option from the pop-up menu.
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BLF Panel
The BLF panel provides the Busy Lamp Field/Direct Station Select functionality for internal lines and 
extensions monitored by the attendant. Each key in the BLF/DSS window provides one-touch access to that 
line or extension. In addition, the BLF/DSS also provides access to EMail and Quick Message.

This area of the screen has a button deÞned for every extension that the user is monitoring. The attendant can 
deÞne Extension Groups that include a speciÞc set of extensions. The tabs at the top of the BLF Panel repre-
sent all of the deÞned Extension Groups. Selecting a different tab allows the attendant to view only the 
extensions that are included in that group.

BLF Identification
Each button includes an LED indicator, and a text label that can include the name and extension of the mon-
itored line. Use the options under the Tools - Preferences menu to determine how the information is dis-
played. The conÞguration option allows these buttons to be displayed in either alphabetical order based upon 
the text label or numeric order by extension. The user can also control which items are included in the text 
label: Þrst name, last name, and extension. Based upon the length of the text label, the BLF entries will be 
resized so that the maximum number of entries can be displayed in the designated area. If more extensions 
are deÞned than can Þt in the BLF panel, then a horizontal scroll bar will be visible at the bottom of the BLF 
area.

The LED colors represent IDLE (gray), BUSY (green), RINGING (green ßash), DND (red) and FORWARD 
(blue).

BLF Call Control
The call control functions interact with the DSS/BLF keys, based upon the status of the active call window. 
When a call is active, clicking on a DSS/BLF button that is gray will transfer the call to that extension. When 
no call is active, clicking on a gray DSS/BLF will dial that extension. 

A conÞguration option allows the user to deÞne the default action to be applied when the attendant clicks on 
a busy BLF with an active call. The available options are:

● Send active call to voice mail for the selected extension

● Put caller on hold and initiate voice over

● Camp caller on second line of selected extension

Performing a right mouse click on the destination BLF will provide access to options other than the default 
action.
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Trunk BLF's
A conÞguration setting is available which enables a Trunks tab within the BLF area. When this tab is 
selected, the BLF area displays an indicator for each monitored trunk. The LED indicator will track whether 
the trunk is Idle or busy. This window is for viewing only and no action on the trunk can be initiated from 
this window. 

Changing the Visible BLF Groups
The system administrator can set up BLF Groups, which can be used to organize the extension list into 
groups of buttons. Each BLF Group is shown as a tab on the top of the BLF area on the main console screen. 
By selecting different tabs, the attendant is able to see the BLF�s that are assigned to that group. Each con-
sole user has the ability to select which BLF groups are visible on the console.

To specify the visible BLF Groups:

1. On the Tools menu, select the Preferences option.

2. Click on the BLF/DSS tab within the Preferences menu.

3. Select the checkbox for all BLF Groups that are to be visible.

4. Selecting a Group and using the Move Up and Move Down buttons will change the position 
of the tab for the selected group.

5. Click on OK to save the BLF/DSS conÞguration.

Changing the BLF/DSS Button Appearance

To change the format of the BLF/DSS labels:

1. On the Tools menu, select the Preferences option:

2. Select the BLF/DSS tab on the Preferences menu.

3. Set the Label Format Þeld to the type of information to be displayed on the BLF/DSS key. 
Valid formats are:
- Extension Only
- Name Only
- Extension followed by Name (Extension+Name)

4. Click OK to save your settings.

Status Bar
The Status Bar appears at the bottom of the main screen and provides relevant information about the current 
state of the application.

In the sample screen below, the status bar shows the name of the currently logged in attendant, the Day/
Night mode setting, and the current date and time.
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Automatic Voice Greetings

Automatic Voice Greetings
The PC Attendant Console is capable of playing a personalized greeting for every call received by the atten-
dant. The greetings are from a pre-recorded Þle, created in the attendant's own voice. When an incoming 
external call is answered, the PC Attendant Console will automatically play the voice Þle - both the caller 
and attendant can hear the greeting. This option is conÞgurable per user, so that each attendant can use their 
own recorded Þle or disable the playback option. This feature can be used to present a professional appear-
ance to customers by delivering an accurate and consistent greeting with each call.

The ability to play a personal greeting requires that a CTI device (CTU Adapter, P/N 0890059) be 
installed on the attendant�s keyset telephone. The Personal Greeting features will not be enabled if this 
device and the associated device drivers are not installed on the host PC.

Playing a Personal Greeting

To setup a personal greeting:

1. Record a greeting using a utility such as the Windows Sound Recorder and save the Þle on 
the attendant PC.

2. On the Tools menu, select the Preferences option.

3. Select the Personal Greeting tab on the Preferences menu.

4. Select the option Enable Voice Greeting on the top of the Personal Greeting menu.

5. Specify the Þle name of the recording to be used or press the Browse button to select a Þle.

6. Press OK to save the settings.
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Call Forwarding
Call Forwarding permits an extension user to redirect their calls to another extension. Call Forwarding 
ensures that the user�s calls are covered when they are away from their work area. The types of Call For-
warding are:

● Call Forwarding When Busy or Not Answered
Calls to the extension forward when busy or not answered.

● Call Forwarding Immediate
All calls forward immediately to the destination, and only the destination rings.

● Call Forwarding When Not Answered
Calls forward only if they are unanswered (Ring No Answer).

● Call Forwarding Immediate with Ringing
All calls forward immediately to the destination, and both the destination and the PC Atten-
dant extension rings.

Call Forwarding will reroute calls ringing an extension, including calls transferred from another 
extension. The extension user must enable Call Forwarding from their phone. 

Forwarding the Attendant Console

To forward the attendant console:

1. On the Function Toolbar, select Call Forward.
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2. On the Call Forward menu, select the Call Forward option.

3. Select the conditions and destination for forwarding calls.

4. Select Start to initiate the call forward setting.
 

To cancel the forward on the attendant console:

1. On the Function Toolbar, select Call Forward.

2. In the Call Forward window, select Cancel Call Forward.

3. Select Start to initiate clearing of the call forward setting.
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Call Log
The Call Log provides a table view of the calls that have been processed by the attendant console. Each call 
record includes the attendant ID, call type (inbound/outbound), call date and time, caller identiÞcation, call 
duration, and line appearance. From this table, the user can sort the entire list based upon any individual col-
umn. The user also has the ability to delete or archive the call log, as well as print the contents. The call log 
also identiÞes any calls that were recorded using the application's RECORD function. Playback of recorded 
calls is also allowed from within the call log window. The attendant also has the ability to re-dial a number 
that is associated with a call log record.

The columns within the Call Log tab can be resized and rearranged. To resize a column, place the mouse 
cursor within the header row, on the right hand edge of the column to be resized. Hold down the left mouse 
button and drag the edge of the column to the new size. To rearrange the order of the columns, place the 
mouse cursor within the header row of the column to be moved. Hold down the left mouse button and drag 
the column into the new position.

To access the Call Log:
1. From the PC Attendant Console�s main menu, select the Windows option, then click Call Log. 

Re-dialing a Number from the Call Log
1. Press the right mouse button to select the Call Log record to be redialed.

2. Select Dial from the pop up menu.

Playing Back a Recorded Telephone Conversation
The Record function is used to capture a telephone conversation from the attendant console and save the 
recording on the PC. The recording is attached to the Call Log record and indicated by the recording icon

(  ) within the Type Þeld.
 

To playback a recording:

1. Press the right mouse button to select the Call Log record that contains the recording.

2. Select Play from the pop up menu. The Playback window will open and the recording will 
automatically start playing.
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The Playback window provides the following controls:

 

Deleting Records from the Call Log

To delete a single Call Log record:

1. Press the right mouse button to select the Call Log record that is to be deleted and select the 
Delete option.

-OR-
1. Highlight the Call Log record to be deleted and from the Call Log menu, select the Delete 

option.

To delete a block of Call Log records:

1. Highlight the records to be deleted.

2. Press the right mouse button within the highlighted block. From the pop up menu, select the 
Delete option.

-OR-
2. From the Call Log record, select the Delete option.

Sending a Call Log Record or Recording Using EMail

To send a call log record or recording using EMail:

1. Press the right mouse button to select the Call Log record to be sent.

2. From the pop up menu, select the EMail option. This will create a new mail message using 
your default EMail client, with the call log detail included in the body of the message. If a 
recording is associated with the call log record, then the sound Þle for the recording will be 
attached to the message.

Printing the Call Log
The PC Attendant provides the capability to print all or part of the call history.

To print the entire Call Log:

1. From the Call Log menu, select the Print option, followed by Print All. This will send the 
entire call log to the default printer.

 

To print selected records from the Call Log:

1. Highlight the records to be printed.

2. From the Call History menu, select the Print option, followed by Print Selected. This will 
cause the selected call log records to be sent to the default printer.

Slider bar - advances as the playback progresses. Dragging the 
slider will change the current playback position within the 
recording.

Play Start/resume playback of the recording.

Pause Suspend playback at the current position.

Stop Suspend playback and set the current position to the beginning 
of the recording.
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Changing the Call Log Layout
The PC Attendant Console provides several options to change the layout of the Call Log. The size and location 
of each column can be modiÞed and the entire Call Log can be sorted based upon any individual column.
 

To change the visible columns within the Call Log tab:

1. On the View menu within the Call Log window, select the Set Visible Columns option.

2. Check each column that will be visible on the Call Log.

3. Press OK to save the settings.
 

To change the order of the columns in the Call Log:

1. Position the mouse cursor within the heading of the column to be moved.

2. Hold down the left mouse button and drag the column to the new position.
 

To change the width of a column in the Call Log:

1. Position the mouse cursor within the heading and on the right edge of the column to be 
resized. When the mouse is in the proper position, the mouse cursor will change to a double-
headed arrow.

2. Hold down the left mouse button and drag the border of the column to the new width.
 

To sort the contents of the Call Log:

1. Position the mouse cursor within the heading of the column to use for sorting.

2. Press the left mouse button to sort the Call Log in ascending order based upon the contents of 
the selected column.

3. Pressing the left mouse button a second time will sort the Call Log in descending order.
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Archiving the Call Log
Regular maintenance of the PC Attendant Console should include archiving of the Call Log. This operation 
is beneÞcial for reducing the number of call records displayed within the application, and therefore, improv-
ing access when searching for individual records. The archival process also provides a method of backing up 
the call history and storing the records off-line for future access.

The archive operation saves the call history to a Þle using Comma Separated Values (CSV) format. This for-
mat can be viewed using a standard text editor or easily imported into a database or spreadsheet program. 
During the archive operation, the user can specify if the recorded Þles are to be saved or deleted. If the 
recorded Þles are saved, they will be compressed into a zip Þle, with the same Þle name as the archived call 
records.
 

To archive the Call Log:

1. From the Call Log menu, select the Archive option. This will open the Call Log Archive 
menu.

2. Select the Start Date and End Date for the archive. All call log records within this range of 
dates will be included in the archive and removed from the Call Log tab.

3. Select either Save in corresponding.zip to keep the recordings or Delete Recordings to erase 
the recordings. If a zip Þle is selected, the name of the zip Þle will be the same as the archive 
Þle name selected in the next step with a .ZIP extension.

For example, if ARCHIVE_OCT.CSV is selected for the archive Þle, the zip Þle will be 
ARCHIVE_OCT.ZIP.

4. Enter the name of the archive Þle to be created or use the Browse button to select the Þle.

5. Press Save to create the archive Þle.
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Call Recording
Attendants occasionally have a need to record telephone conversations. The PC Attendant Console provides 
the ability to record active calls and save the recordings as standard sound Þles on the PC hard drive. Each 
recorded Þle is associated with a record in the call log, providing easy access for retrieval of the recordings. 
From within the application, the user can choose to playback the call recordings, archive to another Þle/disk, 
or EMail to another user. The attendant has the option to conÞgure the software to automatically record 
every call, or manually start/stop recording for individual calls.

The user must have the CTU TAPI adapter installed in their phone and properly conÞgured for this function 
to operate successfully.

Note: If the CTU adapter�s connection is lost and then recovered at any point while the PC Attendant is 
running, the �Record� function will not work correctly until the PC Attendant is restarted.

Recording the Active Call
The PC Attendant Console provides the ability to record the active call on the attendant console and save the 
recording as a Þle on the PC. This Þle can then be played back within the application or EMailed as a WAV 
Þle to another user. Recordings are associated with individual entries in the Call Log and can be accessed 
within the Call Log tab.

The ability to record calls requires that a CTI device be installed in the attendant telephone. The 
Recording features will not be enabled if this device and the associated device drivers are not 
installed on the host PC.

To start recording a call:

1. Use the mouse to select Record on the Function Toolbar.
-OR-
1. Press the F8 key on the keyboard.

 When a call is being recorded, the label on the Record button will change to Stop on 
the Function Toolbar.

 

To stop a recording:

1. Use the mouse to select Stop on the Function Toolbar.
-OR-
1. Press the F8 key on the keyboard.

 If recording is stopped and restarted on the same call, the individually recorded ses-
sions will be combined into a single Þle.

 If a call that is being recorded is placed on hold, the recording will automatically be 
restarted when the call is retrieved from hold.

 

To automatically record all calls:

1. On the Tools menu, select the Preferences option.

2. Select the Recording tab on the Preferences menu.

3. Select the Record All Calls option.

4. Select OK to save the new setting.
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Camp On

Camp On
With Camp On, an extension user may call a busy extension and wait in line without hanging up. When the 
user Camps On, the system signals the busy extension with two beeps indicating the waiting call. The call 
goes through when the busy extension becomes free. Camp On helps busy extension users know when they 
have additional waiting calls. It also lets callers wait in line for a busy extension without being forgotten.

Using Camp On for a Busy Extension

To initiate a Camp On shortcut using a BLF/DSS key:

1. With an active call on the attendant phone, double-click on a busy BLF/DSS key to camp the 
current call on to the selected extension. 

For this shortcut to be enabled, the Tools®Preferences BLF/DSS menu must have 
the Camp option selected as the current double-click action.
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Central Office Calls, Answering

Central OfÞce Calls, Answering
The system provides ßexible routing of incoming CO (trunks) calls to meet the exact site requirements. This 
lets trunk calls ring and be answered at any combination of system extensions. 

Answering Incoming Calls
When a call arrives at the attendant position, the PC Attendant generates a notiÞcation tone and adds a new 
Ringing entry to the Active Call List.

The attendant can answer the call using any of the following methods:

1. Use the mouse to select the Answer function on the Function Toolbar. 
-OR-
1. Press the F1 key on the keyboard.
-OR-
1. Use the mouse to select the Ringing call entry within the Active Call List.

When an inbound call is answered, the state of the call will change from Ringing to Active on the Active Call 
List. If the attendant has another call ringing in at the same time an active call is already in progress, answer-
ing the ringing call will automatically place the active call on hold.

Disconnecting a Call

To disconnect from the active call:

1. Use the mouse to select Hang Up from the Function Toolbar.
-OR-
1. Press the F4 key on the keyboard.

When an active call is disconnected, the call entry will be removed from the Active Call List.
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Central OfÞce Calls, Placing

Placing an Outbound Call
When the attendant console is idle (no active call), the user can initiate an outbound call. The PC Attendant 
provides the Dial function to initiate a call to an internal or external number and special dialing features for 
the BLF/DSS tab and Directory tab.

Placing a call using the Dial function

1. Use the mouse to select Dial on the Function Toolbar.
-OR-
1. Press the F5 key on the keyboard.

2. Enter the number to be dialed in the Destination Þeld within the Data Entry area.

3. Select the Start option within the Data Entry area to place the call.

Dial an extension using a BLF/DSS key

1. With the attendant set idle (no active call), click on a BLF/DSS key to dial that extension.

Placing a call using the Directory 

1. Within the Directory, double-click on the directory entry to be call or press the right mouse 
button and select Dial Extension from the menu.

-OR-
1. Within the Directory, press the right mouse button on the desired entry and select Dial 

Extension from the menu

Disconnecting a Call

To disconnect from the active call:

1. Use the mouse to select Hang Up from the Function Toolbar.
-OR-
1. Press the F4 key on the keyboard.

When an active call is disconnected, the call entry will be removed from the Active Call List.
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Conference
Conference lets an extension user add additional inside and outside callers to their conversation. With Con-
ference, a user may set up a multiple-party telephone meeting without leaving the ofÞce. The Aspire system 
allows an extension user to Conference up to 31 internal and/or external parties together (the originator 
would be the 32nd party reaching the maximum of 32). 

With an active call on the attendant console, the PC Attendant Console can establish a conference using 
either the Conference function or the Directory menu.

Setting Up a Conference Call

To initiate a conference using the Conference function:

1. Use the mouse to select the Conference function on the Function Toolbar.
-OR-
1. Press the F6 key on the keyboard.

2. Enter the telephone number of the conference party into the Destination Þeld within the Con-
ference menu.

3. Select the Start option within the Conference menu to initiate the conference.

4. When the destination answers, announce the conference and then select Complete to create 
the three-way conference call. If the destination does not answer or does not want to partici-
pate in the conference, select the Disconnect option.

5. To add additional parties, repeat the above steps.
As long as there is one other internal party connected in the Conference, the PC 

Attendant can click Hangup to exit the Conference and the other parties can continue to 
talk.

 

To initiate a conference using the Directory tab:

1. Use the right mouse button to select the directory entry to be added to the Conference.

2. On the pop up menu, select the Conference option to initiate the Conference.

3. When the destination answers, announce the conference and then select Complete to create 
the three-way conference call. If the destination does not answer or does not want to partici-
pate in the conference, select the Disconnect option.

4. To add additional parties, repeat the above steps.
As long as there is one other internal party connected in the Conference, the PC 

Attendant can click Hangup to exit the Conference and the other parties can continue to 
talk.
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Directory / Contact List
The PC Attendant maintains different directories for internal (Directory) and external (Contacts) numbers. 
The internal directory serves as the company directory and includes all employees' names, extensions, 
EMail, department, and alternate numbers. The external directory serves as an on-line phone/address book 
for frequently dialed external numbers.

The user views the directory by using functions within the Directory option on the Main Menu. The direc-
tory/contact list is opened in a separate window - select either the Directory or Contacts icon on the left of 
the window to view the listing. Each listing provides a search box for quickly searching for a name. The con-
venient search capability can be used to Þnd individuals by Þrst name, last name, or partial name. Entering 
alphabetic characters in the Search Þeld will Þlter the displayed entries using the name Þelds. If the attendant 
enters 'B', then all of the directory listings that have the Þrst name starting with B will be displayed. Entering 
'B  D' will further Þlter those entries to only show the listings with a Þrst name starting with B and a last 
name starting with D. Filtering by last names only can be accomplished by entering a space followed by the 
characters in the last name. 

The Directory can also be used to initiate a call by selecting any of the telephone number Þelds associated 
with a directory or contact list entry.

Each entry in the Directory database can contain the following Þelds:

● First Name 

● Last Name 

● Extension 

● Title 

● EMail address 

● Location 

● Department 

● Supervisor Name 

● Supervisor Telephone Number 

● Assistant Name 

● Assistant Telephone Number 

● Alternate Contact Numbers

● Notes

● Ability to Hide the Directory Entry or Hide the BLF Button

Each entry in the Contact database can contain the following Þelds:

● First Name 

● Last Name 

● Telephone 

● Title 

● EMail address 

● Company Name 

● Company Dress 

● Alternate Contact Numbers

● Notes
Aspire PC Attendant User Guide ◆ 29



Operation
Directory / Contact List
Operations that can be performed on the Directory/Contact List include the following:

● Adding a new entry to the Directory/Contact List

● Modifying an entry in the Directory/Contact List

● Deleting an entry from the Directory/Contact List

● Searching the Directory/Contact List

● Printing the Directory/Contact List

● Changing the Directory/Contact List Tab Layout

● Call Handling within the Directory/Contact List

● Sending a message from the Directory/Contact List

The columns within the Directory and Contacts list can be resized and rearranged. To resize a column, place 
the mouse cursor within the header row, on the right hand edge of the column to be resized. Hold down the 
left mouse button and drag the edge of the column to the new size. To rearrange the order of the columns, 
place the mouse cursor within the header row of the column to be moved. Hold down the left mouse button 
for a second or two until the cursor changes from an arrow to an arrow with a square, then drag the column 
into the new position.

The data can be sorted by name, number, or department name. Simply click in the header row of the column 
which should be used for the sort process.

An import utility is provided with the Contacts listing that allows databases from third-party applications to 
be inserted into the console directory. The import utility requires that the import Þle be a CSV (comma-sepa-
rated values) Þle. The attendant maps the Þelds within the CSV Þle to the corresponding Þelds within the con-
sole directory. The data from the PC Attendant�s Contacts listing can be exported to a CSV format as well.

NOTE: Only authorized users have the ability to modify the Directory.

Adding a new entry to the Directory

To add a new entry to the Directory:

1. Click Window-Directory to open the Directory/Contact List window.

2. On the File menu within the Directory window, select New Entry. 

3. Enter the appropriate data in the designated text Þelds. 
To enter an alternate number, select New in the Alternate Number area, and enter the 

telephone number and type. 

If a Department name is to be used, make sure to creat the Department prior to creat-
ing a new Directory entry.

4. Click Save to add the new entry to the Directory and exit the Directory Maintenance menu. 
- OR -

If multiple new entries are being added, click Add to save the new entry and clear the form for 
the next new entry.

To add a new Department to the Directory:

1. Click Window-Directory to open the Directory/Contact List window.

2. On the File menu within the Directory window, click New Department. 
A Department must Þrst be added here before it can be entered in a new Directory entry.

3. Enter the name of the department and click OK. 
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Modifying an entry in the Directory

To modify a directory entry:

1. Highlight the directory entry to be modiÞed. 

2. From the File menu, select Properties. 

3. Update the Þelds by entering new data in the appropriate text boxes. 
Quick Message is available only to those extensions whose properties are not indi-

cated as �Hidden� in the Telephony Administrator�s Directory tab. Make sure any exten-
sion which is to use the PC Attendant application is not hidden, as the Quick Message is 
used with the attendant, and this could cause log-in issues for the attendant.

4. To modify an Alternate Number, double-click within the Number Þeld of the Alternate Num-
ber to be entered. Modify the contents of the Number Þeld. 

5. Click on Save to apply the changes to the Directory. 

Deleting an entry from the Directory

To delete a single directory entry:

1. Select the directory entry with a right-mouse click. From the pop up menu, select the Delete 
option. 

- OR -
Highlight the directory entry and from the File menu select the Delete option. 

To delete a block of directory entries:

1. Highlight the entries to be deleted. 

2. Right-mouse click within the highlighted block. From the pop-up menu, select the Delete option.
- OR -

From the File menu, select the Delete option.

Searching the Directory and Contact/Personal Lists
The Directory, Contact List, and Personal List menus includes a Search function, which allows the attendant 
to query the listings. The Search capability can be used to Þnd matching entries based upon Þrst name, last 
name, or a combination of Þrst and last name. Partial names can also be entered to Þnd multiple entries that 
match the search criteria. 

To access the Search capability:

1. Click inside the Search Þeld and enter the search criteria. 

To search for entries that match on either Þrst or last name:

1. Enter the full or partial search string in the Search Þeld. 
Example: Entering �John� will list all entries with Þrst names of John and Johnny, as 

well as entries with last names such as Johnson.
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To search for entries that match a full or partial Þrst and last name:

1. Enter the Þrst name, followed by a space, followed by the last name in the Search Þeld. 
Example: Entering �John Stevens� will list John Stevens and Johnny Stevenson.

Example: Entering �S T� will list all entries whose Þrst name starts with S and last 
name starts with T.

To search for entries that match only the last name:

1. Enter a space as the Þrst character in the Search Þeld, followed by the full or partial last name. 
Example: Entering � T� will list all entries whose last name starts with T.

To Clear the Search results:

1. Delete all the characters in the Search Þeld 
- OR -

Press the Esc key on the keyboard while the cursor is in the Search Þeld. 

Printing the Directory or Contact/Personal List

To print the entire directory:

1. From the File menu, select the Print option, followed by Print All. This will cause the entire 
directory to be sent to the default printer. 

To print selected entries from the Directory:

1. Highlight the entries to be printed. 

2. From the File menu, select the Print option, followed by Print Selected. This will cause the 
selected directory entries to be sent to the default printer. 

Changing the Directory/Contact/Personal List Layout
Several options are provided for changing the layout of the Directory, Contact List and Personal List. The 
size and location of each column can be modiÞed and the entire Directory can be sorted based upon any indi-
vidual column.

To change the visible columns within the Directory/Contact/Personal List:

1. On the View menu, select the Set Visible Columns option. 

2. Check each column that will be visible on the Directory. 

3. Press OK to save the settings. 

To change the order of the columns in the Directory/Contact/Personal List:

1. Position the mouse cursor within the heading of the column to be moved. 

2. Hold down the left mouse button and drag the column to the new position. 
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To change the width of a column in the Directory/Contact/Personal List:

1. Position the mouse cursor within the heading and on the right edge of the column to be 
resized. When the mouse is in the proper position, the mouse cursor will change to a double-
headed arrow. 

2. Hold down the left mouse button and drag the border of the column to the new width. 

To sort the contents of the Directory/Contact/Personal List:

1. Position the mouse cursor within the heading of the column to use for sorting. 

2. Press the left mouse button to sort the list in ascending order based upon the contents of the 
selected column. 

3. Pressing the left mouse button a second time will sort the directory in descending order. 

Call Handling within the Directory/Contact/Personal List
Several common call handling functions can be accessed within the Directory, Contact List and Personal 
List. 

NOTE: The call handling functions are not available when the Directory, Contact List or Personal List win-
dow is opened from the Admin utility.

To dial a number within a Directory/Contact/Personal List entry:

1. Double-click on the speciÞc entry to be dialed. 
 - OR -

Press the right mouse button to select the directory entry to be dialed. 

2. From the pop up menu, select the Dial option.  

To leave a message in a Voice Mailbox:

1. Press the right mouse button to select the directory entry. 

2. From the pop up menu, select the Voice Mail option.  

To initiate a supervised transfer to a Directory/Contact/Personal List entry:

1. Press the right mouse button to select the directory entry to receive the call. 

2. From the pop up menu, select the Transfer - Supervised option.  

3. When the party answers, announce the transfer, and then press the Complete button on the 
Transfer menu. 

4. If the destination does not answer or does not want to receive the transfer, press the Discon-
nect button to reconnect to the original caller. 

To initiate an unsupervised (blind) transfer to a Directory/Contact/Personal List entry:

1. Press the right mouse button to select the directory entry to receive the call. 

2. From the pop-up menu, select the Transfer - Immediate option.  
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To initiate a conference with a Directory/Contact/Personal List entry:

1. Press the right mouse button to select the directory entry to add to the conference.

2. From the pop-up menu, select the Conference option.  

3. When the party answers, announce the conference, and then press the Complete button on the 
Conference menu. 

4. If the destination does not answer or does not want to join the conference, press the Discon-
nect button. 

Sending a Message from the Directory
The Directory Tab provides functions to generate EMails, voice mail messages, and quick messages to indi-
viduals in the company directory.

To send an e-mail to a directory entry:

1. Press the right mouse button to select the directory entry. 

2. From the pop-up menu, select the EMail option. This will create a new mail message using 
your default EMail client, with the destination set to the EMail address of the selected direc-
tory entry. 

To leave a message in a Voice Mailbox:

1. Press the right mouse button to select the directory entry.

2. From the pop-up menu, select the Voice Mail option. 

To send a Quick Message to a directory entry (PC Attendant Only):

1. Press the right mouse button to select the directory entry.

2. From the pop-up menu, select the Quick Message option.  

3. Specify the desired Message and Responses within the Quick Message menu. 

4. Select Send on the Quick Message window to deliver the message. 
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Adding a new entry to the Contact/Personal List

To add a new entry to the Contact/Personal List:

1. Click Window-Directory to open the Directory/Contact List window.

2. On the File menu, select New Entry. 

3. Enter the appropriate data in the designated text Þelds. 

4. To enter an alternate number, select New in the Alternate Number area, and enter the tele-
phone number and type. 

5. Click Save to add the new entry and exit the Contact Maintenance menu. 
- OR -

If multiple new entries are being added, click Add to save the new entry and clear the form for 
the next new entry.

To add a new Company to the Contact/Personal List:

1. Click Window-Directory to open the Directory/Contact List window.

2. On the File menu, click New Company. 

3. Enter the name of the company and click OK. 

Modifying an entry in the Contact/Personal List

To modify a list entry:

1. Highlight the list entry to be modiÞed. 

2. From the File menu, select Properties. 

3. Update the Þelds by entering new data in the appropriate text boxes. 

4. To modify an Alternate Number, double-click within the Number Þeld of the Alternate Num-
ber to be entered. Modify the contents of the Number Þeld. 

5. Click on Save to apply the changes to the Contact/Personal List.

Deleting an entry from the Contact/Personal List

To delete a single list entry:

1. Select the list entry with a right-mouse click. From the pop-up menu, select the Delete option. 
- OR -

Highlight the list entry and from the File menu select the Delete option. 

To delete a block of list entries:

1. Highlight the entries to be deleted. 

2. Right-mouse click within the highlighted block. From the pop-up menu, select the Delete 
option. 

- OR -
From the File menu, select the Delete option.
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Do Not Disturb
Do Not Disturb blocks incoming calls and Paging announcements. DND permits an extension user to work by the 
phone undisturbed by incoming calls and announcements. The user can activate DND only while their phone is 
idle. Once activated, incoming trunk calls still ßash the line keys. The user may use the phone in the normal man-
ner for placing and processing calls.

There are four Do Not Disturb options available:

● All Calls

● Outside Calls

● Paging/Intercom/Call Forwards/Transfers

● Call Forwards

Placing the Attendant Console in Do Not Disturb

To activate DND for the attendant console:

1. On the Function Toolbar, select Call Forward.

2. On the Call Forward menu, select the Do Not Disturb option.

3. Select the condition for allowing calls to ring the PC Attendant.

4. Select Start to initiate the Do Not Disturb setting.
 

To cancel DND on the attendant console:

1. On the Function Toolbar, select Call Forward.

2. In the Do Not Disturb window, select Cancel Do Not Disturb.

3. Select Start to initiate clearing the DND setting.
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EMail
The BLF/DSS buttons provide the ability to generate an EMail to individuals assigned to BLF/DSS keys.

EMail: Send an EMail Using a BLF/DSS Key

To send an EMail using a BLF/DSS key:

1. Press the right mouse button to select the BLF/DSS key.

2. From the pop up menu, select the EMail option. This will create a new mail message using 
your default EMail client, with the destination set to the EMail address of the selected BLF/
DSS key. 

The EMail address Þeld within the Directory entry for this extension must be Þlled in 
for this function to be enabled.
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Hold
Hold lets an extension user put a call in a temporary waiting state. The caller on Hold hears silence or Music 
on Hold, not conversation in the extension user�s work area. While the call waits on Hold, the extension user 
may process calls or use a system feature. Calls left on Hold too long recall the PC Attendant. 

Placing a Call On Hold

To place the active call on hold:

1. Use the mouse to select Hold on the Function Toolbar.
-OR-
1. Press the F2 key on the keyboard.

Intercom calls cannot be placed on hold due to TAPI issues. You can, however, Park 
the call in order to answer another call. You can also use Transfer or Conference with 
intercom calls.

Outside calls will be placed into the Þrst available Park. This is required due to the 
TAPI 2 commands and implementation.

When a call is placed on hold, the status of the call in the Active Call List will change from Active to On 
Hold for intercom calls or placed in Park for outside calls.

Retrieving a Call on Hold

To retrieve a call that was previously placed on hold:

1. Use the mouse to select the Held call within the Active Call List.

When a held call is retrieved, the status of the call in the Active Call List will change from On Hold to 
Active. If another call is active on the attendant console when a held call is retrieved, the active call will 
automatically be placed on hold.
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Night Service
Night Service lets system users activate one of the Night Service modes. Night Service redirects calls to their 
night mode destination, as determined by Assigned and Universal Night Answer programming. The system 
allows Night Service to be enabled for each Night Service group, allowing each group to determine when 
their calls should switch modes. A user typically activates Night Service after normal working hours, when 
most employees are unavailable to answer calls. 

There are eight Night Service modes:

● Day 1 / Day 2 Modes - for normal working hours

● Night 1 / Night 2 Modes - after hours (usually evening)

● Midnight 1 / Midnight 2 Modes - late at night to early in the morning

● Rest 1 / Rest 2 Modes - interval usually used for lunch

Setting the Telephone System in Night Mode

To set the system in Night Mode:

1. Press the Night button on the Function Toolbar, when the attendant phone is idle.

2. Select the Night Mode option from the Mode list.

3. Skip the Password Þeld as this is not used with the Aspire system.

4. Select Start to begin the Night Mode operation.
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Paging
Paging allows a user to locate another employee or make an announcement without calling each extension 
individually.

Internal Paging
Internal Paging lets extension users broadcast announcements to other keyset users. When a user makes a 
Zone Paging announcement, the announcement broadcasts to all idle extensions in the zone dialed. With All 
Call Paging, the announcement broadcasts to all idle extensions programmed to receive All Call Paging. An 
extension can be a member of only one Internal Paging Zone. 

By default, the PC Attendant will only display Internal Page Zones 1-9. This can be changed in the Tele-
phony Administrator to display zones 1-64.

External Paging
With External Paging, a user can broadcast announcements over paging equipment connected to external 
Paging zones. When a user pages on of these external zones, the system broadcasts the announcement over 
the speakers.

The Aspire S system allows up to eight External Paging zones. The Aspire system allows up to nine External 
Paging zones, with the additional zone (#9) provided on the NTCPU. All other zones (#1-8) requires a port 
on a 2PGDAD module. In addition, each external zone has an associated relay contact. When a user pages to 
a zone, the corresponding contact activates (closes). This provides for Paging ampliÞer control. Refer to the 
Aspire S or Aspire system hardware manual for additional details.

Combined Paging 
Use Combined Paging when you want to simultaneously Page into an internal and corresponding external 
zone. For example, you can Page your company�s warehouse and outside loading dock at the same time. 
Combined Paging is available for Paging zones 1-8 and All Call. Optionally, you can change the Combined 
Paging assignments. For example, in the Aspire system programming, you can associate External Paging 
Zone 1 with Internal Paging Zone 4. When an All Call Combined Page is made, it will include both the 
external zones and the assigned internal zone(s). If the internal page zone is busy or there are no extensions 
in a page group, the announcement will be made on the external zones only.

Displaying Internal Page Zones 1-64

To change the displayed Internal Page Zones:

1. From the Start menu, select Programs - NEC - Telephony Administrator, or double-click on the 
Telephony Administrator icon on the desktop.

2. Click on Telephony Settings. Under the Feature Codes tab, select 00-64 in the Internal Paging 
Zones section. 

3. Close the Telephony Administrator utility by clicking the X in the upper right-hand corner.
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To send a Page:

1. Use the mouse to select Page on the Function Toolbar.
-OR-
1. Press the F9 key on the keyboard.

2. Select the type of page to be generated: Internal, External, or Combined.

3. Select the paging zone within the selected category.

4. Select the Start button to initiate the page.

5. Announce the page.

6. Select the Hang Up option to disconnect from the paging system.
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Park
Park places a call in a waiting state (called a Park Orbit) so that an extension user may pick it up. The PC 
Attendant uses the System Park option when you want to have the call wait in a system orbit. After parking a 
call in orbit, the attendant can Page the person receiving the call and hang up. The paged party dials a code 
or presses a programmed Park key to pick up the call. With Park, it is not necessary to locate a person to han-
dle their calls. A call parked for too long will recall the extension that initially parked it, however the call 
remains in the park orbit until it�s answered. There are 64 Park Orbits (1-64) available for use.

The PC Attendant Console also provides an Unpark function in order to retrieve a call from a park orbit.

Parking/Unparking a Call

To Park the active call:

1. Use the mouse to select the Park function on the Function Toolbar.
-OR-
1. Press the F10 key on the keyboard.

2. Select the park orbit (1 through 64) within the Park menu.

3. Select Start to transfer the active call to the park orbit. The Active Call List is updated with 
the information for the parked call.

4. If the park orbit is currently occupied, a warning message will be displayed. The attendant 
will then be reconnected to the caller and allowed to select a different park orbit.

 

To retrieve a call using the Unpark function:

1. With the attendant console idle (no active call), use the mouse to select the Unpark function 
on the Function Toolbar.

-OR-
1. Press the F11 key on the keyboard.

2. Select the park orbit (1 through 64) within the Unpark menu.

3. Select Start to retrieve the call from the park orbit.

4. If the park location is currently empty, a warning message will be displayed.
 

To retrieve a parked call from the Active Call List:

1. With the attendant console idle (no active call), select the desired entry in the Active Calls 
List. The call will be recalled from the Park orbit and become the current Active Call.
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Quick Message Utility
The Quick Message utility allows the attendant to send a short text message to another employee. Unlike an 
EMail message, a Quick Message is delivered immediately to the destination and automatically displayed on 
the user�s PC screen. The recipient can then quickly send a reply back to the attendant by selecting from a set 
of predeÞned responses. This tool is invaluable for delivering a message to someone who is on the phone or 
when the attendant needs an immediate response. Each user which should be able to receive Quick Messages 
would need to have the Quick Message application installed and the user must be logged in.

The attendant can easily select the text of the Quick Message from a pre-deÞned list of standard messages, 
or compose a short message from scratch. When the message is delivered to the recipient, the message text 
and standard responses are shown on the user's PC screen.

When the user selects a response, the reply is sent immediately back to the attendant. To assist the attendant in 
keeping track of Quick Messages, an entry is added to the Active Call List for each Quick Message and Response.

Accessing the Quick Message Utility
The Quick Message utility can be accessed through the Function Toolbar, BLF/DSS button, or Directory entry.

Quick Message is available only to those extensions whose properties are not indicated as 
�Hidden� in the Telephony Administrator�s Directory tab. Make sure any extension which is to use 
the PC Attendant application is not hidden, as the Quick Message is used with the attendant, and 
this could cause log-in issues for the attendant.

 

To send a Quick Message using the Function Toolbar:

1. Use the mouse to select the Message function on the Function Toolbar.
-OR-
1. Press the F7 key on the keyboard.

2. Specify the desired Destination, Message and Responses within the Quick Message menu.

3. Select Send on the Quick Message window to deliver the message. 

To send a Quick Message using a BLF/DSS button:

1. Press the right mouse button to select the BLF/DSS key.

2. From the pop up menu, select the Quick Message option. 
The selected user must have the Quick Message utility currently running on their PC 

for the Quick Message option to be enabled.

3. Specify the desired Message and Responses within the Quick Message menu.

4. Select Send on the Quick Message window to deliver the message. 
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To send a Quick Message from a Directory entry:

1. Press the right mouse button to select the directory entry to receive the Quick Message.

2. From the pop up menu, select the Quick Message option. 
The Quick Message option will only be enabled for users that are currently running 

the Quick Message Client utility.

3. Specify the desired Message and Responses within the Quick Message menu.

4. Select Send on the Quick Message window to deliver the message.
 

Composing a Quick Message
When the attendant initiates the Quick Message utility, the Quick Message menu displayed.

To compose a Quick Message:

1. If the Quick Message utility was initiated from either the BLF/DSS tab or the Directory tab, 
then the Destination Þeld will already be set to the speciÞed recipient. Otherwise, select a 
destination to receive the message from the To: pull-down list. 

Only users who are currently running the Quick Message Client are listed.

Quick Message is available only to those extensions whose properties are not indi-
cated as �Hidden� in the Telephony Administrator�s Directory tab. Make sure any exten-
sion which is to use the PC Attendant application is not hidden, as the Quick Message is 
used with the attendant, and this could cause log-in issues for the attendant.
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2. Select the text of the message to be sent from the Message: pull down list.

3. If necessary, modify the selected message by typing any updates or additional information in 
the Message Þeld.

4. If required, update any of the four Responses shown at the bottom of the menu. Each individ-
ual response can be edited by clicking within the text box and entering alternate text.

5. Select Send to deliver the Quick Message.

6. The recipient sees a message similar to the following:

 

Tracking a Quick Message in the Active Call List:

1. When a Quick Message has been sent, an associated entry is displayed in the Active Call List.

2. The Time Þeld displays a timer that indicates the elapsed time since the message was delivered.

3. When a response is received, the response text will be written within the Quick Message 
entry in the active call list.

Receiving a Response to a Quick Message

Tracking a Response to a Quick Message:

1. When a Quick Message client selects a message response, the reply is displayed within the 
Active Call List.

2. The Response Þeld shows the reply that was selected by the message recipient.

3. The Time Þeld for the message displays a timer that indicates the elapsed time since the atten-
dant received the response.
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Clearing a Quick Message from the Active Call List
The Quick Message and Response appear as an entry in the Active Call List. Quick Messages can be 
deleted from the Active Call List either manually or automatically after a user-deÞned time period.

To manually delete a Quick Message Entry from the Active Call List:

1. Use the right mouse button to select the Quick Message entry to be deleted.

2. Select Delete from the pop-up menu.
 

To set the time period for automatically removing Quick Message Entries from the 
Active Call List:

1. Select the Tools®Preferences option on the console main menu.

2. Select the Active Call List  tab on the Preferences menu.

3. Select the appropriate checkboxes and enter the time period for automatic removal of Quick 
Messages.

4. Press OK to save the changes.
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Telephony Administrator
The Telephony Administrator is used to deÞne the global settings for the console application. In this appkli-
cation, you can deÞne the Aspire service codes used, set up user proÞles, deÞne the default Quick Messages, 
deÞne entries for the Directory and Contact list, and set the options for the BLF/DSS display.

1. From the Start menu, select Programs - NEC - Telephony Administrator, or double-click on the 
Telephony Administrator icon on the desktop. The following window is displayed:

2. Click on Telephony Settings. View the Feature Codes, Voice Mail, and Special Dialing tabs and 
update any settings to match the programming in the Aspire system. 

These settings affect feature codes, paging, voice mail, extension number length, and emergency 
calls.

With the default setting, the voice mail will not function in the PC Attendant. This must be 
enabled in the Voicemail tab by selecting the �Enable Voicemail Interface� check box and entering 
in the voice mail pilot number (as deÞned in Aspire Program 11-07-01). 

In order to use service codes which require 1 or 2 additional digits (such as calling Door Box 
[802 + door box number] or dialing using a trunk group [804 + trunk group number]), internal 
calls must be set to 5-digits in the Special Dialing tab of the Telephony Administration conÞgura-
tion. Any additional dialed digits over �5�, the PC Attendant will determine you are placing an 
outside call and will seize a line.

3. Click the Network tab and enter the TCP port number assigned in the Aspire Program 10-20-01, 
device 1. 

This entry allows the CTI server to make the connection to the phone system. This same port 
number must also be entered in the PC Attendant server setup. That setting allows the PC Attendant 
to connect to the CTI server (this applies even when the CTI server and PC Attendant are installed 
on the same PC.

4. Click on User ProÞles. DeÞne any additional user accounts if required. See User ProÞles on 
page 48 for more.

This section determines the user ID, password, and editing ability for the Directory and Contact 
List.

5. Click on Directory. Verify that all deÞned extensions are shown in the Directory list. Add details to 
individual directory entries as required.

6. Click on BLF/DSS. This section determines the trunk name and whether or not the LED indicates 
when the line is busy (BLF). You can create additional BLF groups and assign names to the individ-
ual trunks as required.

7. Close the Telephony Administrator utility by clicking the X in the upper right-hand corner.
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User Profiles 
The PC Attendant Console will support saving distinct user proÞles within a single system. This function is 
beneÞcial for companies that have different individuals serving as the attendant during the course of the 
business day. Each registered user is assigned a User ID to access the system. The proÞle for each user will 
include their preferences for screen layout, personal voice prompts (if supported), and conÞguration settings.

To Add a User ProÞle:

1. From the Start menu, select Programs - NEC - Telephony Administrator, or double-click 
on the Telephony Administrator icon on the desktop. 

2. Click on User ProÞles. 

3. Click New.

4. Enter the User ID and Password for the proÞle.

5. Determine if the user ID should have editing ability for the Directory and Contact List by 
clicking the appropriate check boxes.

To Delete a User ProÞle:

1. From the Start menu, select Programs - NEC - Telephony Administrator, or double-click 
on the Telephony Administrator icon on the desktop. 

2. Click on User ProÞles. 

3. Click on the proÞle to be deleted.

4. Click the Delete button.

To Edit an Existing User ProÞle:

1. From the Start menu, select Programs - NEC - Telephony Administrator, or double-click 
on the Telephony Administrator icon on the desktop. 

2. Click on User ProÞles. 

3. Click on the proÞle to be edited.

4. Click the Properties button.

5. Change the entries as needed.

 

48 ◆ Aspire PC Attendant User Guide



Operation
Transfer
Transfer

Transfer
Transfer permits an extension user to send (i.e., extend) an active Intercom or outside call to any other exten-
sion in the system. With Transfer, any extension user can quickly send a call to the desired co-worker. A call 
a user transfers automatically recalls if not picked up at the destination extension. This assures that users do 
not lose or inadvertently abandon their transfers. While a transferred call is ringing an extension the system 
can optionally play ringback tone or Music on Hold to the caller, based on the Aspire system programming.

The PC Attendant provides several different methods to initiate a transfer on an active call. The Transfer 
function can be used to initiate a transfer to an external or internal number, while the BLF/DSS tab and 
Directory tab provide special features to initiate a transfer to an internal extension. The PC Attendant also 
provides the option to perform either a supervised transfer or unsupervised (blind) transfer.

Unscreened transfers (hanging up before the PC Attendant operator answers) to a virtual extension 
which rings the PC Attendant, requires the PC Attendant operator to click on the virtual extension�s BLF 
in order to answer the call. Clicking on the call in the Call Control Panel will not answer the call.

Transferring a Call

Redirecting a call with the Transfer function:

1. Use the mouse to select Transfer on the Function Toolbar.
-OR-
1. Press the F3 key on the keyboard.

2. Enter the number to be dialed in the Destination Þeld within the Data Entry area.

3. [Supervised Transfer] Select the Start option within the Data Entry area to initiate a super-
vised transfer. When the destination party answers, announce the transfer and then select 
Complete from the Data Entry area. If the destination does not answer or does not want to 
take the call, select Disconnect from the Data Entry area to reconnect to the original caller. If 
the destination is busy or does not answer, select VoiceMail to send the call to the destination 
voice mail box.

-OR-
3. [Unsupervised Transfer] Select the Blind option within the Data Entry area to initiate an 

unsupervised (blind) transfer. The call will be immediately routed to the speciÞed destination.

Using a BLF/DSS key to redirect a call with the Transfer function:

To initiate a supervised transfer using a BLF/DSS key:
1. Press the right mouse button to select the BLF/DSS station to receive the call.

2. From the pop up menu, select the Transfer - Supervised option. 

3. When the party answers, announce the transfer, and then press the Complete button on the 
Transfer menu.

4. If the destination does not answer or does not want to receive the transfer, press the Discon-
nect button in the Transfer menu to reconnect to the original caller.

 
To initiate an unsupervised (blind) transfer using a BLF/DSS key:
1. Press the right mouse button to select the BLF/DSS station to receive the call.

2. From the pop up menu, select the Transfer - Immediate option. 
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One touch transfers using a BLF/DSS key:

1. Within the BLF/DSS tab, use the mouse to select the station to receive the call. The transfer 
will either be an immediate or supervised transfer, based upon the current setting in the 
Tools®Preferences BLF/DSS menu. When the one-touch transfer initiates a supervised 
transfer, the Data Entry area will become enabled. Select Complete within the Data Entry 
area to complete the transfer or Disconnect to reconnect to the original caller.

-OR-
1. Within the BLF/DSS tab, use the right mouse button to select the station to receive the call. 

2. From the pop up menu, select either Transfer - Supervised or Transfer - Immediate to redi-
rect the call. 

3. If Transfer - Supervised is selected, the Transfer menu will be displayed. Select Complete 
to complete the transfer or Disconnect to reconnect to the original caller.

Note: The one-touch transfer initiated with a BLF/DSS key can be either supervised or unsuper-
vised (blind). The type of transfer is determined by a setting in the BLF/DSS conÞguration 
screen. To change this setting, on the Tools menu, select Preferences. Then select the BLF/
DSS tab and change the setting for One Touch Transfer.

Transferring a call to a directory entry:

1. Within the Directory tab press the right mouse button to select the directory entry to receive 
the call.

2. From the pop-up menu, select either Transfer - Immediate or Transfer - Supervised to redi-
rect the call.

3. If Transfer - Supervised is selected, the Data Entry area will become enabled. Select Com-
plete within the Data Entry area to complete the transfer, VoiceMail to send the caller to the 
voice mail box, or Disconnect to reconnect to the original caller.

Transferring a call to Voice Mail:

Frequently the attendant will need to transfer a caller directly into the Voice Mailbox of a speciÞc 
employee. The PC Attendant Console provides access to the Voice Mail system through the BLF/
DSS keys and the Directory menu.

To transfer to Voice Mail from the BLF/DSS area:

1. With an active call on the attendant phone, double-click on a busy (green) BLF/DSS key to 
transfer to that extension�s voice mail. The active call will automatically be transferred to the 
selected user's mailbox.

For this shortcut to be enabled, the Tools®Preferences BLF/DSS menu must have 
the voice mail option selected as the current double-click action.

-OR-
1. Select the destination BLF using the right mouse button. On the pop-up menu, select the 

Voice Mail option to transfer the caller to the selected user's mailbox.

To transfer to Voice Mail from the Directory menu:

1. Press the right mouse button to select the desired directory entry.

2. On the pop up menu, select the Voice Mail option to send the active call to the selected user's 
mailbox.
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Voice Mail

Voice Mail
Voice Mail ends the frustration and cost of missed calls, inaccurate written messages and telephone tag. This 
frees a company�s busy receptionists and secretaries for more productive work.

Voice Mail: Leave a Message

To leave a message in a Voice Mailbox:

1. Press the right mouse button to select the BLF/DSS key.

2. From the pop up menu, select the Voice Mail option.  
-OR-
1. After calling the extension, click the Voice Mail icon in the function tool bar or the More icon 

then click the Voice Mail option.

Transferring a call to Voice Mail:

Frequently the attendant will need to transfer a caller directly into the Voice Mailbox of a speciÞc 
employee. The PC Attendant Console provides access to the Voice Mail system through the BLF/
DSS keys and the Directory menu.

To transfer to Voice Mail from the BLF/DSS area:

1. With an active call on the attendant phone, double-click on a busy (green) BLF/DSS key to 
transfer to that extension�s voice mail. The active call will automatically be transferred to the 
selected user's mailbox.

For this shortcut to be enabled, the Tools®Preferences BLF/DSS menu must have 
the voice mail option selected as the current double-click action.

-OR-
1. Select the destination BLF using the right mouse button. On the pop-up menu, select the 

Voice Mail option to transfer the caller to the selected user's mailbox.

To transfer to Voice Mail from the Directory menu:

1. Press the right mouse button to select the desired directory entry.

2. On the pop up menu, select the Voice Mail option to send the active call to the selected user's 
mailbox.
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Voice Over

Voice Over lets a user interrupt a keyset extension user busy on another call. With Voice Over, the busy key-
set extension user hears an alert tone followed by the voice of the interrupting party. The keyset extension 
user can respond to the interrupting party without being heard by the original caller. If desired, the keyset 
extension user can easily switch between their original caller and the interrupting co-worker. The original 
caller and the interrupting party can never hear each other�s conversation.

Voice Over could help a lawyer, for example, waiting for an urgent call. While on a call with another client, 
the lawyer�s paralegal could announce the urgent call as soon as it comes in. The lawyer could then give the 
paralegal instructions how to handle the situation - all without the original client hearing the conversation.

Either a keyset or 500/2500 set user can initiate a Voice Over, but only a keyset user can receive a Voice 
Over.

Using Voice Over to a Busy Extension

To initiate a Voice Over shortcut using a BLF/DSS key:

1. With an active call on the attendant phone, double-click on a busy BLF/DSS key to place the 
current call on hold and initiate a voice over call to the selected keyset extension. 

For this shortcut to be enabled, the Tools®Preferences BLF/DSS menu must have 
the Voice Over option selected as the current double-click action.

- Important -
Do not use Voice Over to a user on speakerphone as the 

conversation may be heard by the outside party.
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